
WinEdt and LATEX

Introduction

We will install two pieces of software that will permit us to produce professional-
quality technical documents. These can be easily set up to prepare lab reports,
English and history papers, or anything that needs to be written.

The software WinEdt is used to produce ASCII character file with special
commands that permit you to easily insert complicated mathematical expres-
sions, tables, and high quality graphics.

LATEX is a very extensive software program that takes the ASCII character
file and creates a DeVice Independent (DVI) file that can produce either hard
paper copy or computer screen output.

The first step is to install the appropriate software. The instructions I am
giving assume that you have high speed (not dialup) internet connection. The
advantage of the internet installation is that you will easily be able to update
your software when you want to do so.

Installing WinEdt and LATEX

We will first install the editor, WinEdt. This is the only piece of software that
is not in the public domain. It is shareware and costs $40 for Education folks,
but only $30 for students. However, you don’t need to pay for it. You can try it
for 30 days without charge and even after that you can use the software, except
that you will occasionally receive a reminder that it would be nice to buy it.
The Mathematics Department has a site license for 50 copies of WinEdt. We
have installed it on the machines in the Cushwa 1062 lab and the remainder are
used by faculty.

WinEdt is an extremely powerful editor that can be configured to do more
things than any of us will likely want to do. During the next few weeks I will
show you some that I use most frequently.

If you decide you do not like this editor there are alternatives that I will let
you know about, some of which are freeware. However, WinEdt is the only one
for which I can provide support.

In the installation procedure I am assuming that you are using a PC with
one of the more recent operating systems. If you have a Mac, the set up is
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different and I will discuss this with you.

Installing WinEdt

Here is what you need to do to install WinEdt.

• Go to the web site

http://www.winedt.com/

and read the first 10 lines or so.

• Go to the line “WinEdt 5.5 is the official release of WinEdt. It is available
from CTAN.” and click on the link.

• Choose the USA option to install
WinEdt 5.5 [Build: 20071003] (official release)

• I have my operating system set up so that it saves all download files to a
directory called

C\:Download

Be sure to observe where the file is saved on your computer so that you
can install it.

This download took about 2 seconds on a DSL line.

• Use Windows Explorer to find the file winedt55.exe on your computer and
left click on it to install it.

• Follow the instructions for installation and accept the defaults, unless you
really know what you are doing. These instructions are:

– Accept, after reading, of course, the agreement.

– Install in the default location C:\ Program Files

– Choose Accept in the Start Menu Folder page

– On the Additional Tasks page, leave the first boxes checked but
choose as you like for the other three. I leave them all checked.

– On the Ready to Install page choose Install. The complete installa-
tion took 16 second on my machine.

– After installation you should see a page entitled

Completing the WinEdt Setup Wizard

with a Launch box checked. Leave this box checked and choose Fin-
ish.

2



– WinEdt will start with a file

C:\ Program Files\ WinEdt Team\ WinEdt\ WinShell\ Upgrade.txt

being ready to read and edit. The extension txt indicates this is an
basic ASCII character file.

– If you are interested in how WinEdt works and some of its power,
click the Help menu on the top right of the ToolBox and then click
the first item,

Contents and Index
You should see a Contents listing on the left side of the new page
with a bunch of informational items. This is a very extensive and
sophisticated editor, so don’t be too surprised if you don’t follow all
the explanations. If you do, I need to ask you some questions.

– When you have finished reading all you can take, exit Help and then
exit WinEdt. We are ready to install MikTeX, the configuration of
LATEX that we will use.

Installing MiKTeX

This operation will install LATEX and its friends. The system is large and ex-
tensive and the version we will install will require about half a gigabyte of hard
drive space. Be sure you have a gigabyte or so free, and that your computer will
not be needed for the half an hour or so that will be needed for the installation.

• Go to the web site

http://miktex.org/

• On the left side of this page you will see a menu. Highlight Install MiKTeX
and click on

MiKTeX 2.8

This will take you to the page http://miktex.org/2.8/setup

• Be sure that your operating system is listed as one of the supported plat-
forms. Unless you inherited your computer from a long deceased relative
it will likely be there since these are all the Windows operating systems
released within the past decade. If you are using some version of Unix,
you should see me for a compatible version.

• Go to the bottom of this page and click on

• Move down the page and click on the link

Download “Basic MiKTeX 2.8” Installer
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Be sure that you do not mistakenly click on the link Download MiKTeX
2.6 Net Installer

• You will be asked if you would like to save this file. Click on Save File.

Be sure you observe where this file is being saved so that you can install
it.

The file is large, over 50 mega-bytes, and it took about 8 minutes to save
using my DSL line.

I saved the file, as usual, to my directory
C\:Download

but it doesn’t matter where you save it as long as you know where it is.

• Use Windows Explorer to find the file basic-miktex-2.8.3557.exe on your
computer and left click on it to install it.

• Follow the instructions for installation and accept the defaults, unless you
really know what you are doing. These instructions are:

– Accept, after reading, of course, the MiKTeX copying conditions.

– On the Shared Installation page I suggest having the system installed
for Anyone, but this is your choice.

– Install in the default location C:\ Program Files\ MiKTeX 2.8

– On the Setting page choose the option Letter for Preferred paper,
and leave the option Install missing packages on-the-fly at Ask me
first.

– You will get an Information page that tells what you have chosen.
Be sure that it agrees with what you think you have chosen.

– Left click on Start to begin the installation. The should take about
6 minutes.

– The installation first loads all the needed files. When this is done
you will see a page called Executing. Click on Next on this page.

– You are done, a complete LATEX installation is on your machine.

Configuring PDFTEXify to Include EPS Graphic
Files

This section is optional, but contains some valuable information for those who
want to create PDF files that include Encapsulated PostScript (EPS) Files.
These are the industry standard graphics files, which can be created, for exam-
ple, with Adobe Illustrated.

The TEXify option in WinEdt is a very convenient way to process LATEX
files. Because there may be internal references in a LATEX document, it might
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be necessary to run LATEX on a document more than once so that these references
are correct. For example, my Test-JDF.tex file needs LATEX to run twice since
it automatically gives page numbers on the right top margin as Page xx of yy
Pages. The first time LATEX is run, it determines the number of pages in the
test. The second time LATEX is run it adds the correct page number headings
to the pages.

The TEXify option (Little Brown Bear) detects how many times LATEX needs
to be run and then runs it that many times. Following this, if all is well, it opens
YAP and displays the DVI file. I have used this option when I have run LATEX in
class, and suggested it for your own implementation, so by this time you should
be familiar with the process, if not the exact details of its workings.

There is also an option called PDFLATEX that creates PDF files instead of
DVI files, and then sends these to Adobe Acrobat for viewing. This is useful
because PDF files are the industry and government standard, even the IRS files
are PDFs. The procedure is the same as in LATEX it is just that the output is
in the more widely used PDF format rather than the DVI format.

However, although I want PDF files as my final output, PDFLATEX would
not work for me. My documents commonly include a lot of graphics, and pro-
fessional graphics files are commonly in Adobe Encapsulated PostScript (EPS)
format. This is an ASCII, that is, person-readable, format and these files are
often quite large. They can be converted to the much smaller binary, that is,
machine-readable, PDF format by using Adobe Acrobat software (which is not
freeware). PDFLATEX did not recognize EPS graphic files, so for it to be useful
all the EPS files had to first be converted to PDF files. Since my books might
contain thousands of graphics files, this is not a minor problem.

I got around the problem by creating my own version of PDFLATEX that took
a TeX file, created a DVI file, then created a PostScript (PS) files that included
the graphic files, and finally used the Adobe Acrobat software to convert this to
a PDF file. This worked, but I was never able to get it to include the multiple
runs of LATEX that makes TEXify so useful. Clearly, it would be useful to have a
PDFTEXify option as well that would incorporate the nice features of TEXify but
create PDF files as output, and additionally permitted the inclusion of graphics
files in EPS format.

I contacted the developer of WinEdt, Aleksander Simonic, and told him
about my problem, and in this latest version of WinEdt he has included an
option to solve this problem. You may never need to include EPS graphics files
in your documents, but if you want to have the option of doing so, here is how.

First you need some (free) software, called GhostScript for creating PostScript
files.

• Go to the internet site

http://pages.cs.wisc.edu/~ghost/

• Click on the line GPL Ghostscript.
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• This should take you to the site

http://pages.cs.wisc.edu/~ghost/doc/GPL/index.htm

• Go to the link

http://sourceforge.net/projects/ghostscript/

• At that site you will find a green box that says Download GhostScript.
Find the line that says GPL GhostScript 8.70 and click on it.

• Transfer the file to where ever you like to save download files and run the
.EXE file to install GhostScript.

• Accept the default setting, and note that 40 meg of hard drive space is
required.

• When the installation finishes there will be a window tell you where your
personal information is located.

• You probably don’t need to read the Readme file, just exit out of Explorer.

Now we need to do a minor configuration in WinEdt and we are done.
We need to change PDFTEXify, so go to

Options/Execution Mode/TeX Output

Then change PDFTEXify Output to the last entry, that is, to

tex -> ps -> pdf (dvips + Ghostscript)

and click OK.
Now if you run using the the Brown Bear with the Adobe symbol in the

background it will

• Close the current PDF file if it is open.

• Run LATEX as many times as it needs in order to get all the references
correct,

• Create the DVI file from the TeX file,

• Create a PS (PostScript) file from the DVI file,

• Convert the PS file to a PDF file, converting both text and graphics,

• Save the PDF file in the directory with the TEX file,

• Open the PDF file in Adobe Acrobat.
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Testing the system

We will do a couple of brief tests to see that the editor and programs are
working as they should, and then we can get on with realizing the real power of
the system.

• Go to the Desktop and click on the WinEdt icon. It is a white box with
a pencil pointing to it.

• Open a New file by going to the File menu or clicking on the blank sheet
icon on the Toolbar.

• Enter the following lines

\documentclass{article}

\begin{document}
This is a trial of \LaTeX.

\end{document}

• Go to the File menu and click Save As Save the file as Trial1.tex in some
directory that you will keep the files for this course.

• Click the Brown Bear icon on the ToolBar. It is the one to the left of
the LATEX icon. This should send you to a program called YAP (for Yet
Another Processor) where you will see the output

This is a first trial of LATEX.

• Let’s assume that this actually worked. If not, don’t panic, we will sort it
out easily, I think. Close YAP and return to WinEdt. Change to the line

This is a trial of \LaTeX.

to

This is a trial of \LaTeX.
Here is an equation set inline,
\(D_x \sin(x) = \cos(x),\)
and here is this same
equation set as display
\[D_x \sin(x) = \cos(x).\]
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• Save this files as Trial2.tex and click on the Brown Bear icon again. YAP
should give you the output

This is a trial of LATEX. Here is an equation set inline, Dx sin(x) = cos(x),
and here is this same equation set as display

Dx sin(x) = cos(x).

• You are probably not impressed, since this you could probably do this
almost as easily in Microsoft Word. But try the next one in Word.

• Close YAP, add a blank line below the line

\[D_x \sin(x) = \cos(x).\]

and add

Here is another example of a mathematical expression that is set inline
\(D_x\frac{x^2 + 3x - 4}{x - 1} = 1,\)
and here is this same
equation set as display
\[D_x\frac{x^2 + 3x - 4}{x - 1} = 1.\]

• Save this file as Trial3.tex and click on the Brown Bear icon again to get

Here is another example of a mathematical expression that is set inline
Dx

x2+3x−4
x−1 = 1, and here is this same equation set as display

Dx
x2 + 3x− 4

x− 1
= 1.

One important thing to notice that there was hardly any difference be-
tween setting the expression as inline and setting it as display. In Word
the equations would be set very differently.

There are many other advantages, but this is probably enough for one session.
However, while we are downloading we might as well get the text material that
we will be using.

Documentation on LATEX

A Google search on LATEX will produce many items for self and course study.
Our basic instruction manual will be

The Not So Short Introduction to LATEX2e by Tobias Oetiker and Friends and modified by JDF
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Please download the PDF file for this book from the following site

http://www.as.ysu.edu/~faires/LaTeXFiles/Guide/

You will not want to print the PDF file for the book because there are
interactive links in the PDF file and their use would be lost in hard copy.
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